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General Introduction 
 
How many of you have been wondering looking at the web pages of different attractive web sites that it would have 
been great if some day you also could design and develop your own web pages and web sites? Some of you might have 
even taken some course or training on basic web page designing. If this is the case, you must be familiar with some 
basic HTML tags. To those who have not taken any web designing course and hence are unfamiliar with the HTML 
codes, let web design not sound something very tough and challenging like climbing Mt. Everest. In the next sections of 
this training kit under creating websites, we will gradually teach you how to start creating a simple website. As you 
move ahead following the advice mentioned in the lesson, you will soon find out that it is not a difficult task in itself. 
 
 
What is a World Wide Web? 
 
World  Wide Web or simply web makes the usage of internet or world wide computer network easier. This type of 
network got developed in the 1960s. In the first days, using the internet was not that easy. One had to learn sophisticated 
commands so as to actually gather information lying on different operating systems. It was just as late as in 1992 that a 
group of researchers under the leadership of Berners Lee developed the Web which allowed to look at the resources of 
the internet without the need to have the knowledge of commands. The development of web browsers in the last few 
years have made life lot easier.  
 
The idea of hypertext, which is a method to connect or link data and pages dates back to the 1960s.  However, it was 
only in the 1990s that  Berners Lee and other researchers introduced the concept of hypertext in the Internet by creating 
the HTTP-HyperText Transfer Protocol. In fact, it was only after the development of HTTP that concept of the World 
Wide Web came into existence. 
 
You would find a million sites in the Internet today. You may not only find information of different domains in the web 
but also open your own business by creating a website about your business. If you are interested in learning how to 
develop a website, you will also be able to find this information in the website. 
 
 
What are web pages and HTML? 
 
Before we said that both HTTP and hypertext is based on the World Wide Web. The Web on the other hand is based on 
HTML - the Hyper Text Markup Language. The HTML uses special  commands named tags for defining the contents 
and format of hypertext documents. The web-browsers interpret these commands and display the text and the images as 
required for display on the screen of the computer. 
 
Besides the description of the format of the text and the position of the images in the web pages, HTML also can be 
used for other purposes. For instance, hyperlink conveys the browser to to go to a new web page in the internet and 
display the contents of the page on the computer screen. In Pic.1. that follows, you will see a web page being displayed 
on the web browser window. 
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Pic. 1. A typical web page being displayed on the browser window. 
 
What are web pages and web sites? 
 
Web site or web nodes – These are collection of connected or closely related web pages and files. Web sites generally 
are designed for a particular topic or domain and contain information of an individual or an organization. In every 
website is a special web page known as the homepage or main page. All the visitors of your site will first visit this page. 
The visitors will be able to visit other pages of your site or some other websites by clicking on the hyperlinks located in 
this page. The hyperlinks could connect to web pages located in the same computer or any computers connected to the 
internet. A typical structure of a website is shown in Fig.1. 
 

 
                              
 
 
 
 
 
 
 
 
Fig. 

1. A 
typical structure of a website 
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As illustrated in Fig.1.,  there are several sections of the website. From the home page, one may navigate to any of the 
other pages. 
 
Web sites reside on web server. A web server is a special computer which manages the access to the web pages of the 
websites. Generally, websites are developed in the local or standalone machine and once ready, the website is published 
in the website. The web server in turn is connected to the internet which makes it possible to view pages from the 
website in the world wide web. Besides the internet, web sites and correspondingly web pages can also be placed in the 
intranet, a network limited to the internal organization. Some of the pages, however, may be connected to the wider 
Internet as well. 
 
 
Finding out the webserver 
 
Before taking to the process of developing a web site, you would need to find a webserver on which you are planning to 
host the website. In majority of the cases, it is the ISPs or the Internet Service Providers which provide the web hosting 
services. For this, the ISPs allocate a certain amount of space in the web server for storing the web files. Simple 
websites may be placed in the web space provided by the ISPs but bigger and complex websites are advised to host in a 
dedicated web server where one is offered not only bigger web space but additional services like support for scripts and 
other facilities. Finding an appropriate web server is not a big deal. You may find one most appropriate for you by 
contacting one of the local ISPs or spending sometime searching in the web. 
 
 
Objectives of the website 
  
In order to decide what contents you would be placing in the website, first and foremost, you would need to be clear 
about the objectives of the website. For simplicity, let us imagine that you want to develop a website for your 
organization, which is a software development company. Obviously, you would have a homepage, where you would 
need to put some introductory text of your company. Then you would possibly put some other pages like Software 
Products, Release News, Downloads, Staff Profile etc.  
 
Hence, on the basis of the above information, you can develop a diagram of the website to be developed as shown in 
Fig.2. 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
Fig.2. 

Diagram of a simple website to be developed. 
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Running Web Page Editor (SeaMonkey Webpage Composer) 
 
SeaMonkey Composer is a HTML editor that comes integrated with the Seamonkey Suite. With this composer, you may 
design and develop a simple website without the need to learn the HTML tags. The design and development takes place 
by simple principle “What you see is What you get” like many HTML editors. To run the SeaMonkey Composer, all 
you would need to do is go to the main menu and select  Applications -> Internet -> SeaMonkey Web browser(en). This 
is shown in Pic.2. 
 

 
 
Pic.2. Running the SeaMonkey Web Browser(en). 
 
For those users having some confusion on hearing the name SeaMonkey for the first time, please be informed that the 
same initial Mozilla suite from version 1.8 onwards began to be called SeaMonkey. 
 
Once you SeaMonkey Web Browser (en) gets displayed on your computer screen, you would need to go to  
File -> New->Composer Page  
This is shown in Pic.3. 
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Pic.3. SeaMonkey Composer at a first glance. 
 
The composer window would look like as shown in Pic. 4. 
 
As with any standard editor application, the SeaMonkey Composer has the main menu and the toolbar in the topmost 
section of the window along with four basic tabs at the bottom, namely the “Normal”, “HTML Tags”, “<HTML> 
Source”, “Preview”. 
 
A view of each of these tabbed windows are shown below in Pics. 4, 5, 6, 7. 
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Pic.4.  SeaMonkey Composer at a first glance 
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Pic.5. HTML Tags tab window of the SeaMonkey Web Composer 
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Pic. 6. <HTML> Source Tab  SeaMonkey Web Composer 
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Pic. 7. Preview tab window SeaMonkey Web Composer 
 
 
Let us briefly talk about the designation of these tab windows. 
 
The “Normal Tab Window” 
This is like any text editor. With the help of the elements in the tool bar and the main menu, you may either enter any 
text or image and format accordingly in the window page. You would not in the slightest feel that you are developing a 
website using some HTML editor. You would feel as if you are working in some usual text editor. 
 
 
For instance, in the “Normal Tab Window”, I entered a simple text - “You are most welcome to my site!”. Then I did 
some formatting to the text – increased the text size and aligned it to the center using the elements of the tool bar. The 
view of the text in the “Normal Tab Window” is shown below in Pic. 8. 
 
 
 
 

10 



 
Pic.8. Normal tab window view of the text being entered 
 
HTML Tags tab window 
If you now navigate to the HTML Tags tab window, you would notice that the Composer has indeed placed some 
HTML tags to the text by tracing the history of your formatting actions. This is shown in Pic.9. 
 

11 



 
Pic. 9. HTML Tags tab window view for the text being entered 
 
<HTML> Source tab window view 
 
As you work in the Normal tab window, the Composer would actually be working a lot behind the scene. You would 
confirm this by tabbing to the <HTML> Source tab window. This is shown in Pic.10. 
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Pic. 10. <HTML> Source tab window view for the text being entered 
 
Preview tab window view 
 
To know how exactly the entered text would look in a web browser, you would need to click on the preview tab 
window. The preview of the text being entered is shown in Pic.11.  
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Pic. 11. Preview tab window view for the text being entered. 
 
Creating the home page 
 
Web servers have different naming conventions for the home page. While some of them take default.htm as the home 
page, others take index.htm . Basically, a home page is the one that your browser is set to display every time you launch 
your website or click on the Home button. This page is also referred to as the main page for a website from which the 
rest of the site may be explored. 
 
For now, to get started we may rename the page that we have entered one string "You are most welcome to my site!" as 
index.htm and hence regard it as the home page. 
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Pic. 12. Home page of the website 
 
Adding and formatting text in the webpage 
 
As with several word processors or text editors, there is a rich set of formatting tool available to format the text in the 
webpage. For formatting purpose, we may use the Format menu in the main menu as shown below in Pic. 13: 
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Pic. 13. Format Menu  
 
Using the submenus available under the menu Format, we can do a lot of formatting things to any text like selection of a 
particular font, changing the size of the font and styles, changing the position of the text and so on. 
 
For instance, as in the case of Pic.13, the text "Welcome to the home page of Hari's site" has been aligned to the middle 
of the page, text color and size changed. Formatting the text can also be done alternatively by using the formating 
elements available in the tool bar menu, located just below the standard tool bar.  
 
Viewing the website being designed 
 
To get a picture of how a webpage or website being designed actually would look like, you may opt either clicking on 
the "Preview" tab at the bottom of the page or click on the "Browse" button in the main tool bar located just below the 
main menu. The web page shown in Pic.13. When browsed by clicking on the "Browse" button would look like as 
shown in Pic. 14. 
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Pic.14. Web page being designed after browsing in the Browser window 
 
Adding pages to the website 
For adding new pages to the website, all you would need to do is simply either click on the "New" button  on the 
standard tool bar or select 
 
 File->New->Composer Page (Ctrl+Shift+N) 
 
As a result, you will have a blank Composer page displayed on the screen. Then, please follow the steps as mentioned 
above and put the contents on the page. Save the page with either a .htm or .html extension. It is advisable that you store 
all the web pages that you plan to include in your website in one folder. This is to avoid confusions while providing the 
links.  
 
Managing links in web pages  
 
   Creating hyperlinks between webpages  
    Hyperlinks between web pages can be created by highlighting the text fragment that you would want to give a 
hyperlink and then select "Create Link..." on the pop up menu being displayed on right clicking the mouse with the text 
fragment highlighted. This is shown in Pic. 15. 
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Pic. 15. Creating hyperlinks to selected text fragment 
 
Once you click on "Create Link...", you will be displayed the following window as shown in Pic.16. 
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Pic. 16. The Link Properties window displayed on clicking on "Create Link..."  
 
Then you would need to choose the file to which you would want to provide the hyperlink to. On clicking the "Choose 
File..." button, you will be displayed the "Open HTML File " window as shown in Pic. 17. 
 

 
Pic. 17 Open HTML File window 
  
On the left side of this window, we have the file locations. The tabs in the upper right top corner also indicate the 
locations. On the right portion of the window, you can see the names of the files or folders on a particular highlighted 
file location on the tabs above. You may choose any of the relevant web page that you intend to provide hyperlink to. In 
this case, it is the myuniversity.html file. 
 
After selecting the  myuniversity.html file, you would need to click on the "Open" button. As a result of which, you 
would return back to the "Link Properties..." window as shown in Pic. 18. 
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Pic. 18. Link Properties window with the name of the webpage that you are hyperlinking to. 

is is shown in Pic. 19. 

 
Click on the "OK" button and then you have successfully created a hyperlink. This is shown in Pic. 14. On browsing the 
web page on the browser and clicking on the "My University" hyperlink, you would be displayed another web page 
with the contents about the University. Th
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Pic. 19. A snapshot of the University Page. 
 
Creating internet links to webpages 
 
For creating an internet link, all you would need to do is provide a valid URL – Universal Resource Locator address of 
 web page in the internet instead of a hyperlink to the local web page. Otherwise, the procedure for creating any of 

most the same.  For instance, in the University page, an internet link of http://www. tribhuvan-
university.edu.np has been provided to the text fragment, "Official website address". This is shown in Pic.20. 
 
 

a
these links is al

21 



 
Pic. 20. An internet link to the text fragment "Official website address" 

n clicking on the internet link, we are displayed the official site of the university's website as shown in Pic.21. 
 
O
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Pic. 21. Official website of Tribhuwan University being displayed on the browser window 

   Creating email links 
All you would need to do create an email link is write down mailto:"your_email_address" in the link property window. 
For example, mailto:"coldwinter@wlink.com.np

 

"
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Pic. 22.  Creation of an email link 
As you can see on the status bar in Pic. 22 , the highlighted text "email address" has the link 
mailto:"coldwinter@wlink.com.np"
 
If you click to the email link, by default an email client gets launched. If your email client is not cofigured, you would 
need to configure it initially.  
 
Editing hyperlinks 
 
If you will have to make changes to the hyperlink, all you would need to do is  make changes in the Link properties . 
For this, you would need to call the Link property window by taking your mouse cursor on the hyperlink and selecting 
Link Properties.. from the pop up menu as you right click the mouse. The Link Property window is the one shown in 
Pic. 18. On clicking the "Advanced Edit..." button, you will be displayed the  "Advanced Property Editor" as shown in 
Pic.23. 
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Pic. 23. Advanced Property Editor 
 

y selecting the attributes/properties and coB rrespondingly putting the values, we can different effects to the hyperlink. 

ou would want to edit the actual page that the hyperlink points to, you would need to select "Edit 
r" from the popup menu displayed after right clicking the mouse. This is shown in Pic. 24. 

 
 
 

But this is out of scope of this tutorial. For advanced property edition, you would need to consult other sources of 
information. 
 
But alternatively, if y
ink in New Composel
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Pic. 24. Edit Link in New Composer 
 
This command displays the web page being linked by the hyperlink in a New Composer window, where you can make 
changes to the content of the page. 
 
 
Embedding Multimedia elements in web pages  
 
Inserting pictures and images in the webpages 
 
You may insert pictures and images in the webpages in two ways using SeaMonkey Web Composer. You may either 
select  
       Insert->Image...  from the main menu or click on the Image button on the tool bar. 
 
When you have done one of the above, you will be displayed the window as shown in Pic. 25. 
 

Pic. 25. Image Properties Window 
 
You would to specify the location of the image that you are inserting in the webpage. For this, you would need to click 
on the "Choose File... " button. Once you have selected the image, you may consider entering some text in the tooltip 
and alternate text. Usually, one would enter the string that is expected to display as one takes the mouse cursor over the 
image. 

ome more properties may be set in the "Dimensions", "Appearance" and "Link"  tabs but for now, we do not deal with 
em. 

 
S
th
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   Editing images in the webpages  
 
 If for instance, you would like to edit an image in t

ighlighting the image. A popup menu is displayed 
he webpage, all you would need to do is right click the mouse after  
from which you would need to select " Image Properties...". This is 

 
 
Pic. 26. Editing the image by selecting "Image Properties..." 
 
On selecting "Image Properties", you will be displayed the following "Image Properties..." window as shown in Pic.27. 
 
 

h
displayed in Pic. 26. 
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Pic. 27. Location tab of Image Properties window 
 
If you click on the "Dimensions" tab in the above window, you would be displayed the following window as shown in 
Pic. 28. 
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Pic. 28. Dimensions tab in the Image Properties window 

 
 
Pic.29. Appearance tab in the Image Properties Window 
 
To give spacing parameters and solid border to your image, you would need to change the values in the Appearance tab 
as shown in Pic. 29. 
 
 

 
By checking the "Constrain" and selecting "Custom Size" in the window and changing the values of the Width and 
Height, you may change the size of the picture in the webpage. 
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Pic.29. Link tab in Image Properties window 
 
If you want to put some hyperlink to your image then you would need to specify that in the Link tab of the Image 

roperties window as shown above in Pic.29. 

elling. This can be done by clicking on the “Spell” button on the main tool bar menu. On clicking 
e button, you are displayed the following window as shown in Pic.30.. Here the index page that we have designed 

arlier has been taken as an example. 
 

P
 
Publishing the website  
 
Checking the spelling of the text in the webpages 
Before finally publishing your website, it is preferable that you make sure that the text content of your website is spell 
hecked for correct spc

th
e

30 



 
Pic.30. Check Spelling window  
 
As shown in Pic.30.  you may use  several utilities like “Check Word”, “Replace”, “Replace All”, “Add Word”, 
“Ignore”, “Ignore All” etc. to spell check and make the appropriate correcti ons. 
 
 Publishing the website in the local computer 

nce you have finished designing your website, you may like to see it in the local computer. For this, all you would 
n the 
u are 

our site is ready to be placed in the web server. 

 in the web server 

g 

he 
bserver's name etc. For instance, if you are hosting your website through 

ercantile.np, then your website address would be xyz.mercantile.np. In place of xyz, you could write any name that 
you would prefer.  
 
If you would not want the web hoster's name to appear in your site, you would need to buy the server space in some 
web domain like .com, .org etc. 
 
Once you have acquired web space, you would be provided user and login password. After successfully logging in to 
the web space provided by the server, you would be provided adminstrative privileges to upload the files, images and all 
other resources. The easiest way to upload the resources is via a ftp server. The SeaMonkey Web Composer has a useful 
utility inbuilt for publishing the website in the web server. If you click on the "Publish" button on the main tool bar, you 
would be displayed the following window in Pic.31. 

  
 
O
need to do is open the homepage and then click on the "Browse" button. You would be displayed the homepage o
browser window. Please make sure that all hyperlinks are working and the pages are displayed properly. Once yo

re that everything is working properly, now ysu
  
  Publishing the website 
 
By now, it is assumed that you have found a web server where you have been provided some web space for launchin
your website. There are several freely available webspace for launching small scale and personal websites. All you 
would need to do is google a bit in the internet. The disadvantages of such a webserver are that the webspace provided 
may be limited, the webserver might not support scripts that you might have possibly embedded in your web pages, t
domain name would entail the we
m
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oad these edited pages in the web 

he 
 thus clearing the web space occupied 

y your web pages. 

e PAN L10n Project works have been carried out with the aid of a grant from the International Development 
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RLUP), National University of Computing and Emerging Sciences, Lahore, Pakistan (NUCES). 

Pic. 31. Publish Page window 

Editing the website already published in the web server 

It is advisable that you actually edit the webpages in your local computer and then upl
server thus replacing the old pages. You cannot edit pages directly in the webserver. 
 
Deleting the website 
 
Removing the homepage from the webspace provided by the web server would delete the link to the website as t
website would no longer be browsable. Then you may remove the rest of the files
b
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